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16. In the confirmation
screen, click on the Syn-
chronize Now button to
start the synchroniza-
tion process immedi-
ately; otherwise click on
the Finish button to
complete the set-up and
save the synchroniza-
tion.

If this is the first time
you have run the syn-
chronization, you may
see the Contacts Syn-
chronization dialogue
described above. If there
are any labels on the
netpad that cannot be
directly mapped, the synchronization prompts you to do this by hand.
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7.7.2.4 Multiple Synchronizations
It is possible to synchronize more than one Agenda and Data files or Outlook folders
by setting up multiple synchronizations. To do this, you may need to create extra
Outlook folders.

1. Select New, then Folder…
from the File menu.

2. Type in a name for the new
folder.

3. Select the type of items to be
stored in the folder (in this
example, Contact Items).

4. Select the folder to create the
new folder in.

5. Click the OK button.

When you create the synchronization, enter
the appropriate paths and file names in the
applications dialogue.
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7.7.3  Synchronizing Your netpad With Microsoft Schedule+
This section details the set-up and day-to-day use of PsiWin to synchronize your
netpad Agenda and Data files or Contacts program with Microsoft Schedule+ 7.0,
7.0a or 7.5 on the PC. The chapter assumes some familiarity with the use of
Windows 95/98/NT 4.0.

7.7.3.1 Software Compatibility
The details for this section assume that you are using PsiWin version 2.3. To check
which version of PsiWin you have, double-click the My Psion icon, and select
About PsiWin 2.x from the Help menu. If you have at least Build 97, then you have
version 2.3.

You must also have a full installation of Microsoft Schedule+ version 7.0, 7.0a,
or 7.5.

Note: You cannot use the Synchronizer with other versions of Schedule+.

7.7.3.2 Creating New Synchronizations
You can create multiple synchronizations on your PC if you have different Agenda,
Data or Schedule files that you wish to synchronize. See “Multiple Synchroniza-
tions” on page 108. You must define at least one synchronization in order to syn-
chronize files.

Required Information
Before creating your synchronization, note the locations of the files you wish to syn-
chronize: the synchronization must be told which files to use.

1. If you are synchronizing an Agenda or Data file, open the file(s) that
you wish to synchronize.

2. Tap the program name at the top of the toolbar. You will see the Open
files / programs dialogue.

3. Scroll through the list until you find your file(s) listed. Make a note of
the path (in this example, c:\Documents\Agenda).
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7.7.3.3 Creating The Synchronization
1. Make sure that your netpad is connected to the PC, and

then double-click on the My Psion icon. Assuming the
machines have linked successfully, you will see several
icons, including one labelled Psion Synchronizer.

2. Double-click on this icon.

3. In the Psion Synchronizer window, click the New button. This launches
the Psion Synchronizer Wizard, which takes you through the steps
required to set up the synchronization. If you have never created a syn-
chronization before, PsiWin bypasses this window and goes straight to
the Synchronization Wizard.
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4. The welcome screen of the Wizard asks you which PC PIM you want to
synchronize with. Highlight the relevant option and click the
Next button.

5. In the Psion section of the Applications dialogue, specify the netpad
files you want to synchronize with.

• To synchronize an Agenda
file, make sure that the
Synchronize My Agenda
box is checked off. You
will then need to specify
the Agenda file to be syn-
chronized. You can either
type in the path and file
name you noted earlier, or
click the button and
browse the netpad’s disks.
If in doubt, use the Browse
button to find your file.

• To synchronize a Data file
or the Contacts program,
make sure that the Syn-
chronize My Contacts
box is checked off.

6. In the Choose contracts program dialogue:

• To synchronize with the Contacts program, leave the next box as Con-
tacts program.
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• To synchronize with a Data
file, click the button.
Next, select Data and specify
the Data file to be synchro-
nized.

You can either type in the path
and file name you noted earlier
or click the button to
browse the netpad’s disk(s). If
in doubt, use the Browse button to find your file. Next, click the OK
button.

7. Specify which Schedule+ Appointment book to synchronize and which
Exchange profile to synchronize with. Normally, you should leave this
as the default setting, but contact your Network Administrator if you
have any doubts.

Important: Note that it is very important that this information is entered cor-
rectly – if it is not, the wrong files may be synchronized, or no syn-
chronization will occur. However, if you do not have an existing
Agenda or Database file on your netpad, the synchronizer can
create them. This is especially useful for a Contacts database - if
you specify a non-existent netpad Datafile, the synchronizer will
create a new one on the netpad that is optimized for use with your
Schedule+ contacts. The synchronization can only create a Data
file if you have selected the option to synchronize a Data file.
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8. Click the Next button.

9. Specify which types of
entry you wish to syn-
chronize. Uncheck par-
ticular entry types if
you do not want them to
be synchronized.

10. Click the Next button.

11. To specify the period
of entries you wish to
synchronize, click the
Set date range
button, select the
period required and
click the OK button.

To specify how the
synchronization will
deal with entries
outside of normal
working hours, select
the appropriate option
from the Agenda
entries to synchronize
section. You can also
change your work
hours by clicking the
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Set work hours button, altering the settings as appropriate and clicking
the OK button.

Next, click on the Advanced button to set up the label mapping.

Note: If you are synchronizing with the Contacts, or have chosen not to synchro-
nize a Data file, you may not be able to click this button. In this case, you
should ignore step 12 and click the Next button.

12. The Contacts Synchro-
nization dialogue
shows a table, listing
the labels for the Con-
tacts section in Sched-
ule+ in the Contact
information column,
and in the Psion label
column you can match
these to their equiva-
lents (if any) in your
netpad Data file. To
match labels:

• Find the Schedule+
label whose func-
tion is the same as
one of your netpad
Data file’s labels,
then click in the box
next to it in the Psion label column.

• Click on the arrow to the right of this box. A drop-down list
appears containing all the Psion labels that you have not matched. Select
the label you wish to assign.

• If you do not wish to synchronize a particular Schedule+ Contacts label,
select <Ignore> from the drop-down list.

Note: Each netpad label can only be matched to one Schedule+ label.
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13. When you have finished matching the labels, click the OK button and
then the Next button.

14. To start the synchronization process immediately, click on the Syn-
chronize Now button, otherwise click on the Finish button to complete
the set-up and save the synchronization.

If this is the first time you have run the synchronization, you may see
the Contacts Synchronization dialogue described above. If there are any
labels on the netpad that cannot be directly mapped, the synchroniza-
tion prompts you to do this manually.
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7.7.3.4 Multiple Synchronizations
It is possible to synchronize more
than one Agenda and Data files with
multiple Schedule+ files. When you
create the synchronization, enter the
appropriate paths and file names in
the Applications dialogue.

7.7.4  Synchronizing Your netpad With Lotus Organizer
This section details the set-up and day-to-day use of PsiWin 2.3 to synchronize your
netpad’s Agenda and data files, or Contacts program, with Lotus Organizer on
the PC.

The section assumes some basic familiarity with the use of Windows 95/98/NT 4.0.

7.7.4.1 Software Compatibility
The details for this section assume that you are using PsiWin version 2.3. To check
which version of PsiWin you have, double-click the My Psion icon on your desk-
top, and select About PsiWin 2.x from the Help menu. If you have at least Build
136, you have version 2.3.

You must also have a full installation of Lotus Organizer. While this section talks
about Lotus Organizer 97 GS (PIM-only installation), the synchronization set-up
procedure is identical for Lotus Organizer 2.1 or 97. If you are using Organizer 97
GS as a PIM with Group Scheduling, then see page 117.
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Note: You cannot synchronize with Lotus Organizer version 2.0 or 2.01.

7.7.4.2 Creating New Synchronizations
You can create multiple synchronizations on your PC if you have different Agenda
or Data files that you want to synchronize. See “Multiple Synchronizations” on page
108. You will need to define at least one synchronization.

Required Information
Before creating the synchronization, you will need to note the locations of the files
you wish to synchronize: the synchronization must be told which files you wish to
use. You must also tell the synchronization the location of your Lotus Organizer file.

1. Open the file(s) that you wish to synchronize.

• Tap the file name at the top of the toolbar.

The Open files / programs dialogue is displayed.

• Scroll through the list until you find your file(s) listed. Make a note of
the path (in this example, c:\Documents\Agenda).

2. On the PC, click on the Start button and select Find then Files or folders.

3. In the Named box type in:

• *.or2 if you have Organizer 2.1,

• *.or3 if you have Organizer 97, or

• *.or4 if you have Organizer 97 GS (PIM only).
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Make sure that the program is looking in the drive where you keep your
Organizer file(s), and that the Include subfolders box is checked off.

4. Click the Find Now button.

You should now have a list of Organizer files. If you double-click on
the vertical line to the right of In folder, it will expand the view to
include the whole path of the file. In the example above, the path and
file name of the first file in the list would be C:\lotus\orga-
nize\chris.or4.

Note: If you have not previously created an Organizer file, this list will be
empty. To create an Organizer file, open Lotus Organizer. Select Save as
from the File menu. Give the file a name and click the Save button. Then
return to step 2.
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7.7.4.3 Creating The Synchronization
1. Make sure that your netpad is connected to the PC, and

then double-click on the My Psion icon. Assuming the
machines have linked successfully, you will see several
icons, including one labelled Psion Synchronizer.
Double-click on this icon.

2. In the Psion Synchronizer window, click the New button. This launches
the Psion Synchronizer Wizard, which takes you through the steps
required to set up the synchronization. If you have never created a syn-
chronization before, PsiWin will bypass this window and go straight to
the Synchronization Wizard.
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3. The welcome screen of
the Wizard asks you
which PC PIM you want
to synchronize with.
Highlight the relevant
option and click the
Next button.

4. In the Applications dia-
logue, enter the path for
the Agenda, Data and
Organizer files you want
to synchronize.

In the Psion section,
specify the netpad
files you want to
synchronize with.

To synchronize an
Agenda file, ensure that
the Synchronize My
Agenda box is checked
off. Specify the Agenda
file to be synchronized.
You can either type in the
path and file name you
noted earlier or click the button to browse the netpad’s disk(s). If
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in doubt, use the Browse button to find your file.

To synchronize a Data file or the Contacts program, make sure that the
Synchronize My Contacts box is checked off.

5. To synchronize with the Contacts program, leave the next box as
Contacts program.

• To synchronize with a Data file,
click the button. Next,
select Data and specify the Data
file to be synchronized.

You can either type in the path
and file name you noted earlier
or click the button to
browse the netpad’s disk(s). If in
doubt, use the Browse button to
find your file. Next, click the OK button.

The Scheduling environment section of the dialogue can normally be
ignored. However you will need to change this if your copy of Lotus
Organizer has been specifically set up to connect with cc:Mail or Notes,
or to work over a network. You should consult your Network Adminis-
trator if you believe this may be true in your case or, if you are using
Organizer 97 GS as a PIM with Group Scheduling. See section 7.7.5 on
page 117.

6. Specify your Lotus Organizer file. You may either type in the file name
(including its directory) or click the button to browse for the file
(in this example, c:\lotus\organize\chris.or4).

7. Click on the Next button.
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Important: It is very important that this information is entered correctly – if it
is not, the wrong files may be synchronized, or no synchronization
will occur. However, if you do not have an existing Agenda or Data-
base file on your netpad, the synchronizer can create them. This is
especially useful for a Contacts database - if you specify a non-
existent Datafile, the synchronizer will create a new one on the
netpad that is optimized for use with your Organizer contacts. The
synchronization can only create a Data file if you have selected the
option to synchronize a Data file.

8. The next dialogue allows
you to specify which
types of entry you wish
to synchronize. Uncheck
particular entry types if
you do not want them to
be synchronized.

Check in your Lotus
Organizer file whether
the Calendar, Anniver-
sary, Planner or To-do
sections have been
renamed. If any of these
names have been
changed in your Orga-
nizer file, you will need
to edit the names in this
dialogue so that they
match.

If the Address section in Lotus Organizer has been renamed, you will
also need to specify its new name in this dialogue.

9. Click the Next button.
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10. To specify the period of
entries you wish to syn-
chronize, click the Set
date range button.
Then select the period
required, and click the
OK button.

To specify how the syn-
chronization will deal
with entries outside of
normal working hours,
select the appropriate
option from the Agenda
entries to synchronize
section. You can also
change your work hours
by clicking the Set
work hours button,
altering the settings as appropriate and clicking the OK button.

Next, click on the Advanced button to set up the label mapping.
Note that if you are synchronizing with the Contacts program, or have
chosen not to synchronize a Data file, you may not be able to click this
button. In this case you should ignore step 11 below and click the
Next button.

11. The Contacts Synchronization dialogue shows a table, listing the labels
for Address in Organizer on the Contact information column, and on
the right you can match these to their equivalents (if any) in your
netpad Data file. To match labels:
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• Find the Organizer label
whose function is the
same as one of your
netpad Data file’s labels,
and then click in the box
next to it in the Psion
label column.

• An arrow appears to
the right of this box. If
you click on this, a drop-
down list appears, con-
taining all the Psion
labels that you have not
matched. Select the label
you wish to assign.

• If you do not wish to syn-
chronize with a particular
Organizer Address label,
select <Ignore> from the
drop-down list.

Note: Each Psion label can only be matched to one Organizer label.

12. When you have finished matching the labels, click the OK button and
then the Next button.
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13. To start the synchroni-
zation process immedi-
ately, click on the
Synchronize Now
button, otherwise click
on the Finish button to
complete the set-up and
save the synchronization.

If this is the first time
you have run the syn-
chronization, you may
see the Contacts syn-
chronization dialogue
described above. If
there are any labels on
the netpad that cannot
be directly mapped, the
synchronization will
prompt you to do
this manually.

7.7.5  Synchronizing With Organizer 97 GS 
(As A PIM With Group Scheduling)

When you use Organizer 97 GS as a PIM with Group scheduling, it uses your Lotus
Notes Calendar and Address book. Because of this, the set up process for the syn-
chronization is slightly different.

1. Follow the steps in “Required Information” on page 109.

2. Follow steps 1, 2 and 3 in “Creating The Synchronization” on page 111.

3. Enter the details of your Agenda and Data files or select the Contacts
program as described in steps 4 and 5 of “Creating The Synchroniza-
tion” on page 111.
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4. In the Scheduling environment
section, select Notes.

5. Enter the Notes server on which
your Calendar file is stored.
However, if the file is on a local
disk, leave this field blank.

6. Enter the file name. If the file is
on a local disk, this should be
the full path to the file, in this
example c:\notes\data\calen-
dar.nsf.

Note: If you do not have this informa-
tion, contact your Network
Administrator.

7. Click the Account tab.

8. Enter your Notes username and password.

9. Click the Next button.

10. Follow steps 10 onwards in “Creating The Synchronization” on
page 111.

7.7.5.1 Multiple Synchronizations
It is possible to create multiple synchronizations to synchronize more than one
Agenda or Data file or more than one Organizer Address section.

To do this, you may need to create extra Organizer sections:

1. Select Customize from the Section menu.

2. Click on the Add button.
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3. Select the type for the new section, type in a name, for example, Work
Calendar, and click OK twice.

4. When you create the synchronization,
enter the appropriate file paths
and names.

5. In the Entry types dialogue in step 10
in “Creating The Synchronization” on
page 111, put the name of the new
Organizer section against the appro-
priate netpad section and uncheck the
rest of the boxes.

6. Click the Next button and carry on with the synchronization as
described in the previous section.
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7.7.6  Using An Existing Synchronization
Once you have set up the synchronization as above, you can use it whenever you
wish. To run an individual synchronization:

1. Connect your netpad and PC.

2. Double-click on the My Psion icon, and then double-click on the Psion
synchronizer icon.

3. Click on the icon for the desired synchronization(s) so that they are
highlighted.

4. Click on the Synchronize button.
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8.1  Introduction
Before you can use the Internet and e-mail programs or the optional 802.11 radio on
your netpad, some basic configuration is necessary.

For instructions on setting up the 802.11 radio, please refer to “802.11 Radio Con-
figuration”, below.

For instructions on using Opera (the Internet browser) and ‘Email’ (the e-mail, fax
and SMS application), please refer to “Internet And E-Mail Settings” on page 128.

8.2  802.11 Radio Configuration
The following are the basic settings necessary to be able to run the netpad on an
802.11 radio network.

1. From Control Panel, select the Ethernet menu.
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2. The If idle, stay connected for and On exit, stay connected for
options can be changed by tapping the time box; the Psiboard will
appear so the times can be changed to the user’s settings.

3. The user can select which LAN device to use by cycling through the
current Settings options. A new connection mode can be created by
pressing New, an existing choice can be updated by pressing Edit,
when the following menu appears.
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4. By selecting Device on the previous menu, the following three options
are shown. Select Lucent WaveLAN / Orinoco Card.

5. By selecting Device options on the previous menu, the following menu
appears. Type the WaveLAN network name using the Psiboard
keyboard. (The network name will be provided by the 802.11 network
administrator).
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6. By selecting the Advanced tab on the above screen, the following menu
appears. Select the Transmit rate from the four options. (The 802.11
network administrator can provide the correct transmission rate). On
completion of selection press OK to exit the menu.

7. Press Done to exit. The following menu will appear. To complete the
802.11 configuration, press OK.

The netpad is now setup to run on an 802.11 network. To logon to an
802.11 network, the user will require a software application such as
Opera or Tekterm.

8. The netpad will return to the Control Panel screen.
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8.3  Signal Strength Indicator
The 802.11 signal strength is shown above the time or date icon. Four bars indicate
maximum strength. If the signal is lost, the antenna icon has a red cross over it.

Signal Strength Indicator
with Antenna Icon
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8.4  Internet And E-Mail Settings
8.4.1  Overview
This section covers some general questions that people ask about using e-mail and
the Internet, and provides a glossary of terms. The later sections list the information
you will need to know before you start setting up the netpad, and then provide step-
by-step instructions.

8.4.1.1 Displaying Online Help
After you’ve set up your netpad, you can display online help about ‘Email’ and
Opera on your netpad. In each program, select Help on … from the Tools menu.

8.4.1.2 Using The Internet On netpad
You can use your netpad to:

• Access the Internet and view web pages using the Opera program.

• View locally stored web pages and graphics files.

• Download files e.g. additional programs for your netpad.

8.4.1.3 Using E-mail On netpad
You can use your netpad to send and receive e-mail messages using either one, or
both, of the following methods:

Connecting By Telephone Line To A Remote Mailbox
This is when you make a ‘live’ connection to your e-mail mailbox via a telephone
line (without needing a PC). For example, you could access your personal mailbox
by dialing your Internet Service Provider (ISP), or access your work mailbox by
dialling your company's service provider or office mailbox.

What to do next…
If you want to access your work mailbox, you will first need to contact your
network administrator to find out whether you can make a ‘remote’ (dial-up) con-
nection to your mailbox. See “Types Of E-mail Account” on page 129 to con-
tinue.
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Connecting A PC To Access Your Mailbox
This is when you connect directly to a PC that can access your mailbox. Using Psi-
Win's ‘Email Synchronization’, you can write e-mails offline on your netpad, and
then connect to your PC to send and receive messages.

How do I do this?
To access your mailbox via a PC, you will first need to install PsiWin on the PC
and set up ‘Email Synchronization’. This manual does not include information
on ‘Email Synchronization’. If you wish to use ‘Email Synchronization’, see the
PsiWin CD ROM.

8.4.1.4 Types Of E-mail Account
There are a number of different types of e-mail account. See the list below to find
out which types of account you can connect to using the e-mail program on
your netpad.

Personal Dial-up Account
This could be a dial-up e-mail account which you’ve signed-up for with an Internet
Service Provider (ISP).

Which ISPs can I use?
You can use most ISPs which use ‘Internet standard’ methods for connecting to
your e-mail account. However, some ISPs (such as America Online) use propri-
etary methods for connecting, and cannot be accessed by your netpad (i.e. you
must use a PC). Move on to ‘Setting up your netpad’ to continue.

Remote (e.g. Office) E-mail Account
This could be an e-mail account at your workplace, e.g. using Lotus cc:Mail or
Microsoft Mail.

How do I find out if I can use my account?
You will need to find out from your network administrator whether you can
access your e-mail mailbox using this type of account. If you can, move on to
‘Setting up your netpad’ to continue.
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Web-based E-mail Account
This is an e-mail account that you must connect to using a Web browser, e.g.
HotMail or Yahoo! Mail.

Note: You can’t connect to this type of account using the e-mail program.

To use web-based e-mail, you must first set up your netpad for Internet
access. You will need to use the Opera program to access your e-mail pro-
vider’s Web site.

8.4.1.5 If You Don’t Have An Internet/E-mail Account
You will require an e-mail account before you can access the Internet and send and
receive e-mail messages on your netpad.

• To get a personal e-mail account, you must ‘sign-up’ with an Internet
Service Provider (ISP). ISPs usually provide an e-mail account as part of an
Internet access package.

• Most ISPs will provide software (e.g. a CD-ROM) which will help you set
up Internet access and the e-mail account on a PC.

Important: Some ISPs require that you connect to them using a PC in order to
sign-up. If you can’t do this, contact the ISP to find out if you can
sign-up without using a PC.
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8.4.1.6 Glossary Of Terms 
DNS

The Domain Name System is an address book, which allows computers on the
Internet to find each other by using ‘IP addresses’ and ‘Hostnames’.

E-mail
An e-mail (electronic mail) is a text message that is sent over the Internet.

Hostname
A human readable version of an IP address, e.g. www.psionteklogix.com could
be the same as the IP address “194.129.243.153”.

IP address
A computer’s unique Internet address, e.g. “194.129.243.153”, used by comput-
ers to communicate with each other.

ISP
Internet Service Providers are companies that provide you with access to the
Internet. An ISP ‘account’ normally includes the facility to send and receive e-
mail using a personal e-mail address.

POP3/IMAP4
Internet ‘protocols’ (standards) for receiving e-mail.

SMTP
An Internet protocol used for sending e-mail.

TCP/IP
An Internet protocol used by computers to communicate with each other.

8.4.2  Setting Up Your netpad 
8.4.2.1 How To Use Opera/Email
To access the Internet and send and receive e-mail on your netpad you must have
the following:

1. An appropriate e-mail account.
To access the Internet and use e-mail, you will need an Internet ‘stan-
dard’ e-mail account.
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2. A Modem.
You will need a modem to connect your netpad to the telephone net-
work. You can use the following types of modem with your netpad:

• Standard external PC modems.

• Infrared-enabled mobile phones with built-in modems.

3. A telephone connection.
If you are using a standard external modem, you will need to connect
your modem to a telephone socket. If you are using a mobile phone,
your network operator will need to enable your SIM (Subscriber Iden-
tity Module) card so that you can make fax and data calls on your
phone. If your phone has been enabled for fax and data calls, you
should have two extra phone numbers. Contact your network operator
if you are unsure whether your phone's SIM card is ‘data-enabled’.

8.4.2.2 Getting Help
If you are having connection problems, you can find information about connecting
using specific service providers, modems or mobile phones on our Web site at
www.psion.com/mobile.

8.4.2.3 What Information Do I Need? 
Before you can set up your netpad, you will need to find out some information about
your modem and your Internet e-mail account by:

• Checking any documentation your ISP supplied about your Internet
account, or contacting your network administrator at work.

• Checking your ISP’s Web site for technical support.

• Contacting your ISP by e-mail or phone for technical support.

• Checking the Psion Teklogix Web site at www.psion.com/mobile for
details of worldwide ISPs and to use the ISP configuration wizard.

Note: The PsiWin CD-ROM contains ‘templates’ for popular Internet Service
Providers, including those in the UK, US and Germany. You can use these
templates to help you set up your e-mail account quickly.
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Information Checklist 
The checklist in Table 8.1 shows what information you will need to set up your
netpad. Only your ISP or your network administrator can supply all the information
required about your Internet e-mail account.

Information You Need Where To Find It Write It Here

Speed at which you should
use your modem (called the
baud rate).

Your modem’s documentation.

Phone Number you need
to dial to connect to your
ISP (often called a Point of
Presence or POP).

From your ISP/administrator.

Username for your Inter-
net account.

From your ISP/administrator,
e.g. “jrook” or “nd44”.

Password for your Inter-
net account.

From your ISP/administrator,
or you may have chosen this
yourself.

POP3 or IMAP4 server
address (for incoming mes-
sages).

From your ISP/administrator
e.g. “pop3.myisp.com”.

SMTP server address (for
outgoing messages).

From your ISP/administrator
e.g. “smtp.myisp.com”.

E-mail Address (your per-
sonal address).

From your ISP/administrator
e.g. “myname@myisp.coml”.

Table 8.1 Information Checklist
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Some service providers require additional information to ‘log on’ to their server.
You may need the following information when using some service providers.

8.4.3  Setting Up E-mail On netpad 
If you have collected all the information in the checklist, you are now ready to set up
your netpad to connect to your ISP.

8.4.3.1 Connecting The Modem (Serial)
1. If you are not using a radio for communications, connect your netpad to

the modem using the netpad’s serial cable.

What Do I Need To Do This?
To connect your netpad serial cable to your modem you may require a Psion
Teklogix modem cable adaptor. You can only use a Psion Teklogix adaptor,
which can be obtained from your local distributor.

2. Connect your modem to the telephone socket and switch on
the modem.

Optional Information Where To Find It Write It Here

IP Address (if your ISP’s
server doesn’t provide one
automatically).

From your ISP/administrator
e.g. “194.129.243.153”.

DNS Addresses (primary and
secondary DNS addresses if
your ISP’s server doesn’t
provide them automatically).

From your ISP/administrator
e.g. “123.255.78.90” and
“123.255.78.92”.

Mailbox Login (if different
from your Internet account
username).

From your ISP/administrator.

Mailbox Password (if differ-
ent from your Internet account
password).

From your ISP/administrator,
or you may have chosen this
yourself.

Table 8.2 ISP Additional Information
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8.4.3.2 Setting Up Dialling 
When you connect to the Internet, your netpad will need to dial your service pro-
vider’s telephone. You can set up different dialling ‘locations’ so that your netpad
knows how to dial the number correctly, e.g. if you're dialling from the ‘office’ loca-
tion, you might need to add a ‘9’ before the number you want to dial.

To set a dialling location:

1. Move to the System screen and tap Control Panel on the Toolbar.

2. Open the Dialling icon to display the dialling settings.

3. Tap on the Current location line, and select the location you’re dial-
ling from:

• Select Home if you can dial without needing a prefix number.

• Select Mobile if you’re using a mobile phone.

• Select Office if you need to use a prefix (‘dial-out’) number before dial-
ling, e.g. ‘9’.

Location Options
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If you don’t want to use any of these pre-defined locations, you can add a new loca-
tion by tapping the New button and entering the appropriate details.

4. Tap on Edit and check that the dialling settings are correct for your
location (this is not necessary for the ‘Mobile’ location), e.g. you may
need to change the Area code.

5. Tap OK when you have finished setting up your dialing location.

8.4.3.3 Setting Up The Modem 
To specify the type of modem you are using:

1. Move to the System screen and tap Control Panel on the Toolbar.

2. Open the Modems icon to display the modem settings.

3. Tap on the Current modem line, and select the modem you’re using:

4. Select Generic modem settings if your type of modem isn’t shown. If
the generic settings don’t work for your modem, tap New to add a new
entry for your modem. See the documentation supplied with your
modem for the required settings.

Settings For Chosen Location
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5. Tap OK when you have finished setting up your modem.

8.4.3.4 Setting Up Internet Service 
After you have set up your dialling location and modem, you need to create a new
‘Internet service’ and enter your Internet account settings for your service provider.
See “What Information Do I Need?” on page 132 for more details on the
information required.

To set up your Internet service:

1. Move to the System screen and tap Control Panel on the Toolbar.

2. Open the Internet icon to display the Internet service settings.

3. Tap New to create a new Internet service (account).

4. On the Based upon line, select Standard settings, or if you have a
‘template’ file containing your ISP settings, select Settings from file
and choose the file.

Modem Options



Chapter 8: Configuring Communications
Setting Up E-mail On netpad

138 Psion Teklogix netpad EPOC User Manual

5. On the Service page, enter a name for your account and enter your
service provider’s Standard dial-up number (or POP phone number).

6. On the Account page, remove the check from Manual login and enter
the Username and Password for your Internet account.

Enter a valid access phone numberEnter a name for your new account

Enter your username and passwordUncheck this option
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7. If your service provider requires you to specify IP and DNS addresses,
you can set these on the Addresses page. Before you can enter IP and
DNS addresses, you must first remove the checks from the Get IP
address from Server and Get DNS address from server boxes.

8. When you have finished entering the settings, tap Done to return to the
Internet service settings dialogue. The new service you’ve created will
be shown on the Current Internet service line. Tap OK to return to the
Control Panel.

Note: What if I need to use a ‘login script’?

Some Internet Service Providers require that you use a login script when
you connect, e.g. to send details such as your username and password. You
can type in a login script on the Login page of your Internet service set-
tings. See the ‘Email’ document for more information on writing login
scripts.

Either check the box or Either check the box or
enter a valid IP address enter valid DNS addresses
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8.4.3.5 Setting Up The E-mail Program 
Once you have set up your Internet service, you can set up your e-mail account in
the e-mail program.

To create a new account in e-mail:

1. Tap on the Email program icon .

2. Select Email from the Add new account command on the Tools menu.

3. On the Account page:

• Enter a name for your account (this can be anything you want).

• Enter your name as you want it to appear on all e-mails you send on the
Your name line.

• Enter your e-mail address, e.g. “my.name@myisp.com”.

• If the Mailbox type line is displayed, choose the mailbox type,
e.g. ‘POP3’ or ‘IMAP4’.

Either a name for the account
Enter a name that you wish
to appear on messages

Enter your e-mail address
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4. On the Outgoing page:

• Enter your outgoing mail (SMTP) server address, e.g.
“smtp.myisp.com”.

5. On the Incoming page:

• Enter your incoming mail (POP3 or IMAP4) server address,
e.g. “pop3.myisp.com”.

• Enter your Mailbox login (or username) and Mailbox password
(these may be the same as your Internet username and password).

6. Tap OK when you’ve finished entering your e-mail account settings.

You are now ready to use your Opera and e-mail applications.

Enter your outgoing mail server address

Either your incoming mail server Enter your mailbox
address (POP3 or IMAP4) username and password
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9.1  Introduction
You can print from most of the programs on the netpad, including Data, Agenda,
Word, Contacts, Sheet, Sketch and Program.

To print, you need one of the following:

• A printer, which is IrDA (Infrared) compatible, if you wish to print files
using Infrared.

• PsiWin installed on your PC, if you wish to print files via a PC.

• A Serial Printer Link to connect to a serial printer.

Before you start printing, you need to specify:

• The method by which you are going to print.

• The “printer driver” for the printer you wish to use.

9.2  Setting Up The Printer 
You can select the standard printer you normally use to print out files on the netpad
from the System screen. The printer you select in the System screen is used for all
programs unless you select a different printer from within a program, to use for that
program only.

To select the standard printer:
tap Control Panel on the Toolbar, or select the Control Panel command from the
Tools menu. Select the Printer icon, and select the printer model in the Print to
line.
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To select a different printer to use for an individual program:
open the program for which you want to change from the standard printer.
Select the Print setup command from the Printing commands on the File
menu, and press the Printer button to change the printer model and/or port.

9.2.1  Printing Using Infrared 
You can print directly from the netpad to any Infrared capable (IrDA) printer.

To set up for Infrared printing:

1. Select the Printer icon from the Control Panel in the System screen, or
the Print setup command from the Printing commands on the File
menu.

2. If necessary, press the Printer button. Select the printer model in the
Print to line and select Infrared as the method via which you want
to print.

3. If you want, check the layout of the document using Print preview, then
select the Print command from the Printing commands on the
File menu.

4. Enter the range of pages and number of copies.

5. Point the netpad at the printer, making sure that the netpad and printer
are no more than one metre apart, and press Print.
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9.2.2  Printing To A Serial Printer 
You can print to a serial printer a Serial Printer Converter to connect to the printer.
To set up your netpad to print via a serial printer:

1. Select the Printer icon from the Control Panel in the System screen, or
the Print setup command from the Printing commands on the File
menu in the program that you want to print from.

2. If necessary, press the Printer button. Select the printer model in the
Print to line and select Serial port as the method via which you want
to print.

You can change the settings for the serial port and handshaking by pressing the Set-
tings button.

9.2.3  Using PsiWin To Print Via A PC 
You can use PsiWin to connect your netpad to a PC. You can then print files from
your netpad to almost any of the printers installed in Windows on your PC, whether
directly connected, or networked to your PC.

1. Select the Printer icon from the Control Panel in the System screen, or
the Print setup command from the Printing commands on the File
menu in the program from which you want to print.

2. If you are printing from within a program, press the Printer button.

3. Select Printer via PC in the Print to line.

You can now print a file using PsiWin to print via a PC. Refer to the PsiWin online
help for more information.

9.2.4  Printing To A File 
You can use the netpad to print a document to a file. To set up your netpad to print to
a file:

1. Select the Printer icon from the Control Panel in the System screen, or
the Print setup command from Printing commands on the File menu, in
the program from which you want to print.
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2. If necessary, press the Printer button. Select the printer model in the
Print to line and select File as the method via which you want to print.

3. Press the Settings button to specify the name of the file, and the folder
and disk to which you want to print. Press OK to redisplay the Printer
setup dialogue.

When you print the file, it will be saved in the file you specified in the Print to file
dialogue.

Important: Ensure that you use the correct file name, folder and disk drive. If a
file of the same name already exists, it will be deleted and replaced
with the new file that you are printing.

9.3  Selecting The Printer Model 
You can choose to print to various printer models.

To select a printer:

1. Select the Printer icon from the Control Panel in the System screen, or
the Print setup command from the Print button or the Printing com-
mands on the File menu, in one of the programs from which you
can print.

2. If necessary, press the Printer button. Select the printer to which you
want to print in the Print to line.

3. If required, change the method via which you want to print.

Note: When printing via a PC, you can only change the printer model on the
PC. Refer to the PsiWin online help for more information.
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9.4  Page Setup 
You can change the size of the page and specify other layout settings by selecting
the Page setup command from the Print button or Printing commands on the
File menu:

• Select the size of the page on which you want to print (e.g. A4) and the page
orientation. If the page size you require is not in the list of sizes, select
Custom, and then type in the width and height of the page you want.

• Use the Margins page to change the distance between the edge of the paper
and the text.

• Use the Header and Footer pages of the dialogue to enter the text that you'd
like printed at the top and bottom of each page. You can format the header
and footer text, and insert other information in it, including page numbers
and the date.

• Use the Other page to specify where you want page numbering to begin in
the document, and from which page you want to display the headers and
footers.

9.5  Previewing A Document 
You can see how the document will look when printed by selecting the Print
preview command from the Print button or the Printing commands on the
File menu.

To select the page you want to preview, press the Go to button and enter the number
of the page you want to view.

You can change the setup of the printed page and preview from the Print preview
dialogue by pressing the Setup button to display a list of options:

• To change the layout of the page, select Setup.

• To specify the number of pages shown in the preview and whether you want
to view the margins, select Preview.
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• To change the printer model and method, select Printer.

9.6  Printing A Document 
You can print out all or part of a document from the Contacts, Data, Agenda, Word,
Sheet, Sketch and Program editor programs.

To do this:

1. Tap the Print button or select the command from the Printing com-
mands on the File menu.

2. In the dialogue you need to specify how many copies of the selected
pages you want to print.

3. (In Word you can also change the range of pages to print in a multi-
page document. If you don’t change the range, one copy of the whole
document will be printed.)

4. Press OK to start printing the document.
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10.1  Overview
Your netpad is powered by a powerful Lithium Ion battery pack, which under
normal operating conditions will provide power for up to 8 hours use (See “Prolong-
ing Battery Life” on page 156). The netpad will warn you when the main battery
charge is low.

Note: How long your batteries last will depend upon how you use your netpad.
Your netpad will use considerably more battery power when you are
recording sounds, have the brightness turned up, are using files stored on
a multimedia card, or are using Infrared.

The netpad can be powered from the mains when used in the docking station. When
the netpad is powered from the docking station, it will also charge the battery pack.
The netpad should be connected to the docking station or recharging station as soon
as you start getting the low battery message.

If using your netpad for extended periods when you are unable to use mains power,
it’s best to keep two battery packs. Contact your Psion Teklogix distributor
for details.

Backup power is provided by a rechargeable lithium coin cell. This provides power
when the main battery pack is being changed and provides enough power to main-
tain the memory for a few hours.

10.2  How Do I Check The Battery Power?
To check the battery power, move to the System screen and select Battery from the
Information menu. The Summary pane gives a brief description of the state of the
main battery and the backup battery as well as a percentage of charge remaining.
See “Battery Monitoring” on page 157 for details on the meaning of the data shown.

10.3  Changing The Batteries
If you are using your netpad away from the charger for more than 8 hours continu-
ous use, and have a spare battery pack, you can change it when the battery warning
is displayed. To do this:

1. Ensure that the backup battery is in good condition. (Move to the
System screen and select Battery from the Information menu.)
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2. Switch the netpad off.

3. Press on the battery pack latch to remove it.

4. Push in the replacement battery pack.

10.4  Lithium-Ion Battery Safety Precautions
Do not store batteries at temperatures in excess of +60°C; the optimum storage tem-
perature for maximum battery life is +10°C to +35°C.

Important: It is critical that this safety information be reviewed and that all
warnings be strictly followed.

BATTERIES ARE CONSIDERED HAZARDOUS WASTE. Used batteries must
be disposed of in accordance with the manufacturer’s instructions, taken to an
appropriate local battery recycling facility, or returned to one of the following Psion
Teklogix offices for proper disposal.

Teklogix Inc. Teklogix Corp. Teklogix S.A.
2100 Meadowvale Blvd. 1810 Airport Exchange Blvd. Parc Club Du Golf-Bat 1.
Mississauga, Ontario Suite 500 13856 Aix-En-Provence
Canada Erlanger, Kentucky Cedex 3
L5N 7J9 USA 41018 France

Battery Pack

Direction of
Insertion

Battery
Latch

Battery Contact Pins
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Warning: TO PREVENT the battery from leaking acid, generating heat or
exploding, adhere to the precautions listed below.

• Use only with the authorized Psion Teklogix power adaptor.

• Do not dispose of in fire.

• Do not incinerate or subject battery cells to temperatures in
excess of 100°C (212°F). Such treatment can vaporize the liquid
electrolyte causing cell rupture. Incineration may result in
harmful emissions or explosion.

• Do not charge, use or store batteries below -30º C (-22° F). Bat-
teries must be handled in accordance with all applicable state
and federal laws and regulations.

• The battery incorporates built-in safety devices. To ensure their
proper function, do not disassemble or alter any parts of the battery.

• Do not short-circuit the battery by directly connecting any of the
exposed terminals with metal objects such as wire. Do not trans-
port or store the battery together with metal objects such as neck-
laces, hair pins, etc.

• Do not use or leave the battery near a heat source such as a fire
or heater.

• Do not immerse the battery in water.

• When charging, use the battery charger specifically designed for
the battery.

• Do not crush, puncture, open, dismantle, or otherwise mechani-
cally interfere with batteries.

• Do not directly solder the battery.

• Do not connect the battery to an electrical outlet, vehicle ciga-
rette lighter, etc.

• Do not put battery into a microwave oven or pressurized container.

• Do not use the battery in combination with primary batteries
(such as dry-cell batteries) or batteries of different capacities
or brands.
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• Immediately remove the battery from the device or battery
charger and stop use if the battery gives off an odour, generates
heat, becomes discoloured or deformed, or in any way appears
abnormal during use.

• Do not continue charging the battery if it does not recharge
within the specified charge time.

• The battery may burst or ignite if the battery leaks. Always
ensure that it is away from any exposed flames.

• If a battery should leak, do not allow the contents to come into
contact with your skin or your eyes. If it does, wash immediately
with plenty of cold water and seek medical advice.

• Do not store the battery in extremely high temperatures (e.g., a
vehicle, strong direct sunlight, etc.). This may cause the battery
to overheat or ignite, and it may also reduce the performance
and service life of the battery.

• Do not use in areas where static electricity is greater than what
the manufacturer guarantees.

• Keep batteries out of reach of children.

10.5  Prolonging Battery Life
You can take steps to help your batteries last longer:

• Turn the screen brightness down

• Turn off the remote link when not in use.

• Set Auto switch-off.

• Use Data and Agenda files on the Internal disk (C) instead of an MMC (D),
as the netpad requires more power to write to the multimedia card.

When your netpad is switched off, it is on “standby” and will continue to use a small
amount of battery power. If you are going to leave your netpad switched off for a
long period of time, you are advised to back up your data beforehand because the
batteries will eventually run out.

Note: To check the battery power, move to the System screen and select Battery
from the Information menu.
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10.6  Battery Monitoring
Your netpad battery contains a smart battery monitor that tracks the charging and
discharging of the battery as well as providing information on the current, voltage,
temperature and other information provided by the manufacturer. Because the dis-
charge curve on the voltage of the battery is extremely flat and is strongly affected
by the temperature, it is not possible to give an accurate picture of the charge
remaining in the battery by measuring its output voltage.

In this case it is much more accurate to measure the total charge in the battery and
that is what is presented in the dialogue shown in the System screen by selecting
Battery from the Information menu.

However, there are some circumstances where is not possible for the monitoring
chip to accurately track the current used. This is most commonly the case when the
unit is in standby or the battery has been removed from the netpad. In this case, soft-
ware within the netpad will apply corrections to the remaining battery capacity
figure when the unit is next switched on.

To provide accurate measurements, ensure that you follow the correct procedure for
changing batteries:

Always switch off the netpad before removing the main battery If the battery
monitor status displays “Unreliable”, the software is not able to accurately deter-
mining the amount of capacity left. Ensure that the battery is left to fully charge
before relying on the capacity information given.

Under the Advanced tab on the Battery information screen, there is a parameter
labeled “Degradation”. This is an indicator of the overall condition of the battery
and reflects the number of times it has been charged and discharged. When the Deg-
radation figure reaches 100% the battery should be disposed of and replaced.
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Chapter 11: netpad Accessories
Introduction

11.1  Introduction
The following optional accessories are available from Psion Teklogix. These acces-
sories are compatible with all netpad models in the netpad product range. Please
check the Psion Teklogix web site at www.psionteklogix.com for updates to this list.

11.2  Accessory Product List

ACCESSORY PRODUCTS PART NUMBER MODEL 
NUMBER

DOCKING STATION ITEMS
Docking Station Product Packs
The Desktop Docking Station provides charging and
simultaneous data communications via the RS232. See
Chapter 3: “Docking Station and MMC” for details.
All Docking Station packs are supplied with a Power
Supply Unit, RS232 Serial Cable & AC Power Leads
for the following regions:

• UK and Europe 1201 0039 0002

• Australia, New Zealand & Japan 1201 0040 0002

• North America 1201 0044 0002

netpad Docking Station
This item is offered as a replacement for a lost or
damaged dEsktop Docking Station. It does not include
the PSU or leads.

1201 0041 0001

Universal PSU for Docking Station
This item is offered as a replacement for lost or
damaged PSUs. It does not include the mains lead.

A2032 0047 0002

In-vehicle Docking Station
The In-vehicle Docking Station provides a secure
method for mounting and powering the netpad in vehi-
cles from 12VDC. See page 164 for details.

1201 0050 0001
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ACCESSORY PRODUCTS PART NUMBER MODEL 
NUMBER

BATTERIES AND CHARGERS
875 mAh Li Ion Standard Battery A2202 0002 0002

1400 mAh Li Ion Enhanced Battery A2202 0001 0002

netpad Portable Battery Charger
The Portable Battery Charger provides a convenient
method of charging a single battery pack from mains or
12VDC vehicle power.

NP3001

netpad 4-Bay Battery Charger
The 4-Bay Battery Charger provides a convenient
method of charging a up 4 battery packs from
AC power.

NP3004

CARRYING CASES
There are a range of carrying cases that offer methods of carrying and protecting the
netpad. The carrying cases are available in the following configurations.

Soft Carrying Case (for netpad 1100) c/w shoulder
strap.

1202 0020 0001

Soft Belt Holster (suitable for all netpads) c/w shoul-
der strap.

1202 0023 0001

Soft Carrying Case (for netpad 1200) c/w shoulder
strap.

1202 0026 0001

Soft Carrying Case (for netpad 3500) c/w shoulder
strap.

1202 0025 0001
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ACCESSORY PRODUCTS PART NUMBER MODEL 
NUMBER

CABLES
RS 232 Serial Cable (9-pin Female D-type to netpad) A2203 0003 0002

RS 232 Adapter Cable
The RS232 Adapter Cable has 9-pin Male D-type for
connection to the netpad R232 port and can be used to
connect serial peripherals such as printers, modems or
cell phones to the netpad

A2888 0015 0003

Replacement Power Leads are available for the fol-
lowing countries:

• USA power lead A2032 0036 0001

• UK power lead A2032 0037 0001

• Euro power lead A2032 0038 0001

• Japan power lead A2032 0041 0001

• Australian/New Zealand power lead A2032 0042 0001

MISCELLANEOUS
Replacement Stylus (Pack of 10) 1208 0015 0001

MMC Card Reader (Parallel Port Interface) A2888 0016 0001

16 MB MMC Card A2202 0018 0001

netpad EPOC Developer’s CD
The netpad EPOC Developer’s CD contains all of the
development tools for the netpad.
The latest versions of the files available on the Devel-
oper’s CD are available for download from the netpad
Developer’s Resource web site at:
http://partners.psionteklogix.com/netpad-pdk
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11.3  The In-vehicle Docking Station
The netpad in-vehicle docking station provides a durable and flexible solution for
mounting the netpad in vehicles. It offers the following features:

• Highly adjustable.
The mounting arm can be adjusted to provide the ideal viewing angle, no
tools required.

• Small footprint.
It requires less than a 62 mm x 62 mm (2.5 in. x 2.5 in.) mounting area.

• Securely mounted to a range of surfaces.

• Supports landscape or portrait orientation.

• One-handed release mechanism.

• Charging and Data communications.

• One RS232 port.
For connection to peripherals such as printers, GPS receivers, radio
modems or cell phones.

• Compact 12 VDC power supply.
With cigarette-lighter adaptor (which can
be removed for permanent connection to
vehicle power).
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12.1  General Troubleshooting Tips
You should read this chapter if you have any questions or experience problems using
your netpad.

12.1.1  If An Alarm Doesn’t Ring 
If the alarm sounds are like beeps, your battery is too low to play the alarm sound
you have chosen.

It may also be that the Sound is off so that the alarm screen is displayed but the
sound is inaudible. The alarm screen will indicate if the sound is off or silenced for a
particular period. Use the Sound icon from the Control Panel in the System screen to
switch the sound back on again.

If an alarm is due to ring while you are recording another sound, the alarm will be
postponed until you have finished your recording.

12.1.2  World Times Aren’t Correct In The Time Program
This is likely to be because of “daylight saving” or “summer time” settings (where
clocks are put forward for the summer months).

The dates that clocks are set to change vary from country to country, and sometimes
even within a country; some countries do not use summer times at all. Therefore, the
netpad clock will not change automatically on the date that the clocks change. You
will need to make sure that each zone is set to use its “summer time” setting when
the clocks change in those countries. See the ‘Time User Guide’ document for more
details.
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12.1.3  A File Appears To Have “Vanished”
When you tap on a program icon, the netpad will open the program with the file that
you last used. If you only use one Agenda file, for example, this will always be dis-
played when you tap the Agenda icon.

However, if you move or rename your file, the netpad will not be able to find this
“last used” file when you tap the program icon. So, it looks for a file with a standard
filename (e.g. Word, Agenda, Sheet etc.) and displays this file instead. If there is no
file with this name in the standard folder, a new file is created.

You can re-open the original file from its new location using the Open file command
on the File menu.

12.1.4  If You Forget Your Password 
If you forget a password set for a Word or Sheet file, you will not be able to open
the file again until you remember the correct password.

If you forget the passcode set for the whole machine (see “Setting A System
Passcode” on page 52), you will not be able to use the netpad until you perform a
“hard reset”. All the files on the Internal disk will be lost and cannot be retrieved.

See “How To Reset The netpad” on page 169 for more information.

12.1.5  The netpad Doesn’t Turn On/Off 
If the netpad doesn’t seem to turn on:

• Check the screen contrast to make sure it isn’t set too low.

• Recharge the main battery. If you continue to use the netpad when the main
battery is low, it will eventually not have enough power and the netpad will
switch off. You will not be able to switch it on again until you place the
netpad in the docking station to recharge the battery or replace the main
battery with another, charged one.

If the netpad doesn't seem to turn off:

• Check the automatic switch off time using the Switch on/ off icon from the
Control Panel in the System screen.
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Note: If you use OPL, note that a running OPL program can prevent automatic
switch off if it neither pauses nor waits for a keypress.

12.1.6  How To Reset The netpad 
If you find that you cannot exit a program normally, move to the System screen and
select the List open files command from the File menu. Select the program from the
list and press the Close file button.

If this does not work, or if your netpad appears to have “locked up”, you can always
perform a “soft reset”. This should restart your netpad while preserving most of
your information.

It is worth trying a soft reset if the keys on the netpad do not appear to respond, or if
the netpad appears to switch on and you are sure that the batteries are good (espe-
cially if the contrast adjustment still appears to work), but the screen is otherwise
blank.

To perform a soft reset:
gently press the stylus onto the reset switch. This is located inside the Card Slot
door cover to the side of the MMC slot.

Card Slot Door Latch

MMC Card

Reset
Button
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After a soft reset, any changes to open files (such as Word or Sheet files) will be lost.
Your other files on the Internal disk will almost always be safe.

It is possible (although unlikely) that a program failure causes the reset to lose the
information on the Internal disk; it could even prevent the reset from working at all.
If this happens, you will have to perform a “hard reset”.

To perform a hard reset:
1. Remove the netpad from the docking station.
2. Remove the main battery.
3. Press and hold down the On/Off button (on the top of the unit).
4. While continuing to hold down the On/Off button, press and release the

Reset button.
5. Release the On/Off button.

Important: A hard reset resets the netpad completely, and all information on
the Internal disk will be lost.

12.1.7  Can’t Place The netpad In The Docking Station 
If you are having difficulty putting the netpad in the docking station, you may be
attempting to insert it upside down. Push the netpad into the docking station until
you hear a click.

Speaker

Card Slot Door Latch

Card Slot Door

Stylus

ON/OFF Switch

Docking Station
Charging Contacts

IR Port
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12.1.8  The Command Icons Don’t Work 
If tapping a Command icon has no effect, then you may have moved the Psiboard
behind the icons. Move it to the main area of the screen by dragging the title bar.
Then try again.

12.1.9  The Keyboard Disappears 
If the soft keyboard, the Psiboard, disappears, you can set the Preferences to
‘Always on top’. Then it will remain displayed even when you move from screen to
screen. To do this, display the keyboard and tap the P icon in the top right-hand
corner. Then select Always on top.

If you cannot see the keyboard, you may have minimized it. In
this case, only a small portion of the title bar is displayed in the
bottom left-hand corner of the screen (as shown here). Tap on
the underline maximize symbol to open the Psiboard again.

12.1.10  Using HyperTerminal To Locate A Connection Problem
HyperTerminal is a basic communications program that comes as part of Windows
95/98/NT 4.0.

1. Before using HyperTerminal, right-click on the PsiWin Connection
Server icon, or , and select Close.

2. Start HyperTerminal by clicking the Start button, selecting Programs,
then Accessories, and then HyperTerminal.

Note: This is slightly different in NT 4.0. With NT, click Start, then Programs,
then Accessories, then HyperTerminal and finally, HyperTerminal again.
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3. You should then see an icon named either Hypertrm or Hyper-
trm.exe. Double-click this icon.

4. If you then get a dialogue asking whether you would like to install a
modem, click the No button.

5. In the Connection Description dialogue, type in a name for the Hyper-
Terminal session, then click the OK button.
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6. In the Phone Number dialogue, click on the button on the
Connect using line and select the COM port that you have the PsiWin
cable connected to. Then click the OK button.

7. In the next dialogue, click the button on the Bits per second line
and select the baud rate you have set on the netpad. In the same way,
change Data bits to 8, Parity to None, Stop bits to 1 and Flow control
to Xon/Xoff. Then click the OK button.
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8. If you get an error message saying Unable
to open COM x, then there is another
device using the COM port and prevent-
ing PsiWin from using it. This could also
be due to an incorrectly installed Com
port.

9. If you get a series of characters repeating across the screen at regular
intervals, this means that a signal is coming through from the netpad. In
this case, you should try re-installing PsiWin on the PC.

10. If you get just a flashing cursor in the corner of the screen, try a soft
reset on the netpad. If you still get a flashing cursor after this, it means
that you have either a faulty PsiWin cable or a faulty serial port on
the netpad.

12.2  PsiWin 2.3 Connection Problems 
Using Windows95/98/NT 4.0

This section is a guide to troubleshooting connection problems between a netpad
and a PC running Windows 95/98/NT 4.0 and PsiWin 2.3. It also presumes you have
already gone through the online help documents that come with PsiWin 2.3 and still
have no success in linking. A basic knowledge of using the netpad and Windows
95/98/NT 4.0 is necessary. For information about using Windows 95/98/NT 4.0,
check your Windows manual or contact the Windows 95/98/NT 4.0 helpline.

12.2.1  Tips When Installing PsiWin 2.3
Close any other programs that are running. This includes virus checkers, uninstall-
ers, floating toolbars etc.

If you need to re-install PsiWin 2.3, make sure you uninstall the previous version first:

1. Click on the Start button and select Settings, then Control Panel.
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2. Double click the Add/Remove Programs icon. Select PsiWin 2.3 in
the list and then click the Add/Remove button.

Important: You must re-start your PC before re-installing PsiWin 2.3 or you
will experience problems.

3. See the ‘Installing and Setting Up PsiWin’ document for
more details.

12.2.2  Basic Troubleshooting For Your netpad
1. Close down all applications (especially Comms because it blocks

the port).
To do this, go to the System screen and select Close files from the
Close cascade on the File menu. When asked if you wish to “Close all
files/programs?”, tap the Yes button.
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2. Check that the Remote link is switched ON at the netpad end of
the link.
Go to the System screen and select Link to desktop from the Tools
menu. Check that the link is set to Cable. Tap the OK button to confirm
this setting.

3. Try lowering the baud rate.
The baud rate is set in the Remote Link dialogue. Try 57600,19200 and
9600 in turn. Remember that the lower baud rate will not take effect
until you confirm it by tapping the OK button.

4. Reset the port.
This is particularly useful if you have linked successfully in the past but
the link is now failing. Go to the System screen and select Close files
from the Close cascade on the File menu. Change the option to OFF
and tap the OK button. Select Close files from the Close cascade on the
File menu again and reset the link back to Cable. Then tap the
OK button.

5. Perform a soft reset on the netpad.

12.2.3  Basic Troubleshooting For Your PC
1. Close down any other open applications in Windows.

2. If you have a laptop:

• Make sure you have no PC Cards (PCMCIA cards) plugged in.

• Most laptops have power-saving features that disable the COM ports.
Turn these power saving options OFF.

• If your PC has an Infrared port, make sure it is disabled and your
serial/COM ports are enabled. Psion Teklogix can support you with any
of these issues. Check the laptop’s manual or contact the manufacturers
support department to get these issues rectified.

3. The PsiWin Connection server icon is in the bottom right-hand corner
of your PC Screen. When you are not connected, it is a straight line

. When you have made a successful connection, it becomes a
wiggly line .
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• Right-click the Connection server icon
and choose Properties from the pop-up
menu that appears.

• On the Connections page
of the My Psion Properties
dialogue, make sure that
baud rate is set to
Maximum attainable.

• It is possible for PsiWin 2.3
to conflict with a modem
or mouse. Symptoms are
the mouse pointer intermit-
tently locking up or soft-
ware that uses the modem
intermittently freezing.
Uncheck the COM Ports
that are used by
other devices.

4. If you are using Windows NT
4.0, check that you have at
least Service Pack 3 installed. If necessary, install it or contact your
Systems Administrator.

12.2.4  Device Conflicts
To check for device conflicts:

1. Click on the Start button, select Settings and then Control Panel.

2. Double-click on the System icon.

3. On the Device manager page of the System properties dialogue, check
for icons marked with a symbol.

Note: This symbol means that the marked device is conflicting with another
device. If a modem or COM port is conflicting, this could be a cause of
PsiWin not connecting. Contact the person or organization that supports
your PC to resolve the conflict.



Chapter 12: Troubleshooting netpad/PsiWin
Device Conflicts

178 Psion Teklogix netpad EPOC User Manual

4. There is no Device Manager in Windows NT 4.0. The closest is a list of
IRQs, I/O ports and DMA channels. These are accessed by the Start
button, selecting Programs, then Administrative Tools (Common),
then Windows NT Diagnostics. Select the Resources page in the
Windows NT Diagnostics dialogue box. If you do not have this option
or you are in any doubt about it, you should contact your Systems
Administrator.
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12.2.5  Fax/Modem On COM 1/2/3/4
If you have a Fax/Modem using COM Port 3 or 4, and PsiWin on COM 1 or 2 (or
vice versa), you may have trouble when trying to connect with the netpad.

Because of the way a PC handles COM ports, COM1 and COM3 are ‘linked’, as are
COM2 and COM4. Specifically, they share the same Interrupt Request (IRQ).

In practice, this means that if you have a modem on COM3, it may conflict with the
netpad on COM1 (and the same applies for COM4 and COM2). The solution is to
try using PsiWin on a different port or to assign a different IRQ.

You can check the COM port properties by following the steps above to get to the
Device Manager page and double-clicking on the COM port.

Again, if you are in any doubt about whether you are able to do this safely, you
should contact the person or organization that supports your PC.
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If you have an external modem and have unplugged it to use the Psion Teklogix
serial cable on the same port, you will not get a connection. Windows 95/98/NT 4.0
reserves this port for use with the modem and so you will have to use another port.

12.2.6  The Temp Folder
The PsiWin connection can be affected if you have not specified, or have incorrectly
specified, your Temp folder. To specify this:

1. Click Start and
select Run. Type
sysedit in the dia-
logue and click OK.

A screen with multiple windows is displayed.
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1.

2. Click on the AUTOEXEC.BAT title bar.

3. Look in this window to see if it has a line that starts SET TEMP=. If
this line exists, check that the folder that it points to exists and create
the folder if not.

If this line doesn’t exist, place the cursor on a new line and type SET
TEMP=C:\TEMP.

Close the window and choose Yes when asked if you want to save the
changes.

4. Create a folder on the root of your C drive and call it Temp.

5. Finally, restart your PC.
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12.3  Troubleshooting PsiWin 2.3 
Synchronization Problems

This section discusses various problems that may be encountered when synchroniz-
ing Agenda and Data files, or the Contacts program (with Microsoft Outlook 97/98,
Microsoft Schedule+ 7.0/7.0a/7.5, or Lotus Organizer 2.1/97/97GS).

Some familiarity with these applications, Windows 95/98/NT 4.0, and your netpad
is assumed. You will also need a full installation of your PC PIM.

Note: This section should be used in conjunction with the manual to setting up a
synchronization for each application.

The majority of synchronization problems are caused by setting up a synchroniza-
tion incorrectly. Please make sure you have read the appropriate sections in
Chapter 7: “Connecting netpad To A PC” first. These explain the correct way to set
up a synchronization.

12.3.1  Basic Troubleshooting For Synchronization Problems
By far the most common cause of a synchronization failing, apart from the wrong
files being chosen in the set up, is corruption or spurious entries in one of the files.

To test whether this is the case, synchronize a new Agenda and/or Data file with a
new Outlook profile, Schedule+ file or Organizer file. If this synchronization works
then the problem is with one of the original files.

A process of elimination, by synchronizing one file at a time with blank files, should
highlight which file is at fault. If the synchronization with new files does not work,
look through the list of common problems later in this manual to see if the particular
problem is listed. If not, it is likely that either PsiWin or your PC PIM is not installed
properly (for example, with Outlook 98 you will need a full installation for synchro-
nization to work). See the ‘Installing and Setting Up PsiWin’ document or contact
the supplier or manufacturer of your PC PIM.
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12.3.2  Other Things To Try
1. Delete your netpad details in PsiWin.

When PsiWin 2.3 connects to a machine for the first time, it asks you to
enter a name for that machine. This registers details about your netpad
on your PC. Sometimes this information can become corrupt.

• Click the Start button and select Programs, then PsiWin 2.3, and then
Machine Manager. This displays a list of the currently registered
machines.

• Highlight your netpad and click Delete This Owner, or just click the
Remove details of selected machine button.

The next time you connect your netpad, you will be asked to give it a
name. Type in a different name from the machine name you have
just deleted.

2. Make a new backup and recreate any synchronizations.

3. If this doesn’t solve the problem, try a Tidy/archive operation on your
Agenda file or a Merging in operation on your Data file.

• To perform a Tidy/archive operation in Agenda, open the file, and select
Tidy/archive on the More cascade from the File menu. Change the
Tidied entries are line to Copied to new file. Select All entries on the
Which entries line, and change the Range line to Whole agenda.
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Enter a file name (in this example, Test) and select a folder and disk to
create the file in. Then tap the OK button or press Enter. This will
extract all the information from your Agenda into a new file (in this
example, Test). Note that this is not the same as copying the file.

• To perform a Merge in
operation on a Data file,
open the file and press
Ctrl + N. Enter a name
for the new file (in this
example, Test), select the
folder to create it in and
press Enter. This will automatically launch the new file.

In this new file, press Shift + Ctrl + I. In the Merge in dialogue, change the
Disk and Folder lines to the disk and folder on which your original Data
file is kept, and select the file name on the Name line. Then press Enter.

4. Set up a new synchronization, or synchronizations, to use the newly
created files.

5. If you still have no success, export your PC PIM’s file or folders as text
and re-import them into a new file or new folders. For information on
how to do this, see below for Microsoft Outlook, page 187 for
Schedule+ 7.x, and page 190 for Lotus Organizer.
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6. Check your PC PIM for spurious entries. These include:

• Repeating entries with only one occurrence.

• Alarmed entries with a reminder set for before 1980.

• Entries with a carriage return at the end of the subject line.

• In Outlook, entries with a ‘crossed swords’ symbol. Double-click on the
symbol to resolve the problem.

12.3.3  Exporting And Re-importing A PC PIM With Outlook
1. Create a new folder to receive the information that you are about to

export. To do this:

• In Outlook, select Folder in the New cascade from the File menu.

• Type in a name for this folder (in this example, Test), select which type
of information this folder is going to contain (this should be the same as
the folder you are exporting, in this example, Appointment Items),
and select the top-level folder in the list of folders (in this example,
Personal Folders).

• Then click the OK button. The new folder appears in the folder view in
Outlook (if you have this showing).
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2. Select Import and Export from the File menu.

3. Select Export to a file and click the Next button.

4. Select the folder you wish to export (in this case, Calendar). And click
the Next button.

5. Select Comma Separated Values (Windows) and click the
Next button.

6. Type in a name for the export file (in this example, Calendar.txt) and
click the Next button. Then click the Finish button.

7. To import the file into a new folder, select Import and Export from
the File menu.

8. Select Import from Schedule+ or another program or file and click
the Next button.

9. Select Comma Separated Values (Windows) and click the
Next button.
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10. Type in the name you gave the export file (in this example, Calen-
dar.txt) and click the Next button.

11. Select the folder that you created
earlier (in this example, Test) and click
the Next button. Then click the Finish
button.

Set up a synchronization to use the
new folder.

Note: It may also be necessary to set up a new Outlook profile and import the
data into this. See page 192 for information about creating a new
Outlook profile.

12.3.4  Exporting And Re-importing A PC PIM 
With Schedule+ 7.x

1. Create a new Schedule+ file. To do this:

• Select New from the File menu.

• Type in a name for the new file, for example, Test.

• Click the Save button.

2. To export your data to a text file, open the original Schedule+ file, and
select Text in the Export cascade from the File menu.
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3. Select the type of items you wish to export (in
this example, Appointments), and click the
Next button.

4. Select the date range you wish to export and
click the Next button.

5. In the next two dialogs, accept the
defaults by clicking the Next
button twice.

6. Click the Add All button to export
all the fields and then click the Next
button.

7. Type in a name for the export file, or accept the default, and click the
Finish button.

8. To import, first open the new Schedule file you created earlier by
selecting Archive or Project Schedule in the Open cascade from the
File menu.
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9. In this file, select Text from the Import cascade from the File menu.

10. Type in the path and name of the export file. If you accepted the
default when exporting, this will already be entered. Then click
the Next button.

11. Accept the defaults in the next two dialogs by clicking the Next
button twice.

12. Select the type of data in the export file (in this exam-
ple, Appointments), and then click the Next button.

13. On the final screen, map the fields between the two
Schedule+ files. Opposite each field, to its right it
says IGNORE THIS FIELD. Click on this and a
down arrow appears. Click on this and a list of
field types appears. Select the type that corresponds to
the field on the left. Do this for all the fields and click
the Finish button.

14. Set up a new synchronization to use the new Schedule file.
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12.3.5  Exporting And Re-importing A PC PIM With Organizer
1. Create a new section to receive the information that you are about to

export. To do this:
In Organizer, select Customize from the Section menu.

2. Click the Add button.

3. On the Section type line, select
the type of section you would
like to add (in this example,
Calendar), and type in the
name you wish to use for this
section (in this example, Test).
Then click the OK button.

The new section appears as a tab in the main view in Organizer.
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To Export A Section
1. Select Export from the File menu.

2. On the From section line, select the section that you wish to export (in
this example, Calendar),

3. Select ASCII Delimited Text on the Files of type line and type in a file
name (in this example, Calendar.txt).

4. Click the Export button.

To Import The Information
1. Select Import from the File menu.
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2. On the Into section line, select the section you created earlier.

3. Select ASCII Delimited Text on the Files of type line, and select the
file you exported to earlier (in this example, Calendar.txt).

4. Click the Import button.

5. Set up a new synchronization to use the new section.
It may also be necessary to import the data into a new Organizer file.

6. To create a new Organizer file, select New from the File menu, type in
a name for the file and then click the OK button.

12.3.6  Creating A New Outlook Profile
Creating a new Outlook profile should only be attempted if you have a non-net-
worked copy of Outlook. If you use Outlook on a network that is running Exchange,
contact your Network Administrator.

To create a new Outlook profile:

1. Click the Start button; select Settings, then Control Panel.

2. Double-click the Mail and Fax icon (Mail icon if you have Outlook
98).

3. In the Properties dialogue, click the Show profiles button. A list of all
the Outlook profiles on the PC is shown.

4. Click the Add button.

5. Select Manually configure information services and click the
Next button.

6. Type in a profile name (in this example, Test) and click the Next button.

7. In the Properties dialogue, click the Add button to add an information
service to the new profile.
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8. Highlight Personal Folders and click the OK button.

9. Type in a name for the Outlook file
(in this example, Test.pst) and click
the Open button.

10. Select No encryption and click the OK button.

11. Click the OK button again, and then the Finish button. Click the Close
button to exit the Wizard.

12. Open Outlook, and select Options from the Tools menu.

13. On the General page, select Prompt for a profile to be used and click
the OK button.

The next time you start Outlook, you will be asked which profile you
wish to use.

12.3.7  Outlook: Failed To Open Outlook

This error message can appear just after the start of the synchronization process.
There can be two reasons:
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Your Outlook Profile Has Been Incorrectly Entered
To check this, first make sure you have your profile name: in Outlook, select
Options from the Tools menu.

On the General page, if Always use this profile is selected, your profile name will be
in the textbox next to it. If Prompt for a profile to be used is selected, your profile
name is the one you select when you start up Outlook.

See “Synchronizing Your netpad With Microsoft Outlook” on page 91 to make sure
that this information has been entered correctly in the synchronization properties.

The Path To The Outlook Folder(s) Being Synchronized Is Incorrect
To check the path to the folder, make sure you can see the Folder view in Outlook.
(To show it, select Folder view from the View menu.)

In the example shown here, if you were trying to synchronize the Example folder,
the path would be:

Program Files\Contacts\Example

If you have a top level folder that looks like

Mailbox – [Chris Dickins] or

Outlook Today – [Chris Dickins]

then the path would be:

Chris Dickins\Contacts\Example

See “Synchronizing Your netpad With Microsoft
Outlook” on page 91 to ensure that this information
has been entered correctly in the synchronization
properties.
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12.3.8  Outlook: Failed To Open Custom Form,
Outlook Will Open An Outlook Form Instead

This error message is due to conflicting entries. Find the Outlook entries that have a
‘crossed swords’ symbol. Double-click this symbol to resolve the conflict.

12.3.9  Lotus Organizer 2.1: Synchronizer Cannot Access 
Required Directory

This is due to the incorrect version of a particular file being loaded
(the Organizer API).

To find this file, click the Start button, select Find, then Files or folders.

On the Named: line, type orgapi.dll and make sure that the Look in: line is set to
your C drive (or whichever drive the Organizer files were installed to). Then click
the Find now button. You should get a list of two copies of the file.

Right-click on each in turn and select Properties. One of the files should have a
Modified date of 7th November 1995. Right-click again on the file with this date and
select Delete. Then confirm the deletion and restart the PC.
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12.3.10  Lotus Organizer: Cannot Find xxxx (Section Name)
This error message is due to the section name being incor-
rectly entered in the synchronization properties. Open Orga-
nizer and check the name of the relevant section. Then enter
the section name in the synchronization properties (see
“Synchronizing Your netpad With Lotus Organizer” on
page 108 on how to do this).

12.3.11  Lotus Organizer: Unable To Open xxxx (Section Name)
This is due to a problem in Organizer where, if you rename a
section, Organizer will sometimes not recognize the change.
The solution is to rename the section back to its original name
and change the synchronization properties to reflect this.

To do this, right-click on the relevant section’s tab. Select
Rename, type the original name on the New name line and then click the OK
button. See “Synchronizing Your netpad With Lotus Organizer” on page 108 and
enter this information in the synchronization properties.
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SUPPORT SERVICES AND WORLDWIDE OFFICES

Psion Teklogix provides a complete range of product support services to its custom-
ers worldwide. These services include technical support and product repairs.

A.1  Technical Support
Technical Support for Mobile Computing Products is provided via e-mail through
the Partner Program website. To reach the website, go to www.psionteklogix.com
and click on the Partner Program link, which takes you to the Partner Program page.
Then click on the Log-in button or the Register button, depending on whether you
have previously registered for Teknet or the Partner Program. (Your UserID and
password are the same for TekNet and the Partner Program.)

A.2  Product Repairs
International

For product repairs, please contact your local Psion Teklogix office (see
page A-3).

Canada/U.S.A
Canadian and U.S. customers can receive access to repair services, by calling
the toll-free number below, or via our secure website.

Note: Customers calling the toll-free number should have their Psion Teklogix
customer number or trouble ticket number available.

Voice: 1 800 387-8898 (press option “2”)

Fax: 1 905 812-6304

Web Site: http://service.psionteklogix.com
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A.3  WORLDWIDE OFFICES

COMPANY HEADQUARTERS 
AND CANADIAN SERVICE CENTRE

Psion Teklogix Inc.
2100 Meadowvale Boulevard
Mississauga
Ontario
Canada L5N 7J9
Tel: +1 905 813 9900
Fax: +1 905 812 6300
E-mail: salescdn@psion.com

INTERNATIONAL SUBSIDIARIES

Psion Teklogix GmbH
Jakob Kaiser Straße 3
D-47877 Willich Münchheide
Deutschland
Tel: +49 2154 9282 0
Fax: +49 2154 9282 59
E-mail: info@teklogix.de

Psion Teklogix S.A.
La Duranne
135 Rue Rene Descartes
BP 421000
13591 Aix-En-Provence
Cedex 3; France
Tel: +33 (0) 4.42.908.809
Fax: +33 (0) 4.42.908.888
E-mail: tekeuro@psion.com

Psion Teklogix LTD.
3, Lancaster Court 
Coronation Road High Wycombe
Bucks HP123TD, England
Tel: +44 1494 450666
Fax: +44 1494 450155
WWW: www.teklogix.co.uk
E-mail: tekuk@psion.com

Psion Teklogix AB
Stora Badhusgatan 18-20
411 21 Göthenburg, Sweden
Tel: +46 31 13 15 50
Fax: +46 31 13 57 80
E-mail: info@teklogix.se

NORTH AMERICAN HEADQUARTERS 
AND U.S. SERVICE CENTRE

Psion Teklogix Corp.
1810 Airport Exchange Boulevard
Suite 500
Erlanger, Kentucky
USA 41018
Tel: +1 859 371 6006
Fax: +1 859 371 6422
E-mail: salesusa@psion.com

Psion Teklogix Finland
Metsänneidonkuja 8
02130 Espoo
Finland
Tel: +358 9 4307 8390
Fax: +358 9 4307 8395
E-mail: tekeuro@psion.com

Psion Teklogix Danmark
Vesterballevej 4-6
7000 Fredericia
Danmark
Tel: +45 76 24 0133
Fax: +45 75 94 4679
E-mail: tedk@psion.com

Psion Teklogix Italia S.r.I
Via Galilei, 47
20092 Cinisello Balsamo
Milan, Italy
Tel: +39 2 6604 5410
Fax: +39 2 6604 5412
E-mail: tkxitalia@psion.com

Psion Teklogix Inc. (Singapore)
583 Orchard Road
# 15-01 Forum
Singapore 238884
Tel: +65 735 8108
Fax: +65 733 5990
E-mail: intl@psion.com

Psion Teklogix de Mexico, S.A. de C.V.
Sierra Mojada 626, 2º Piso
Col. Lomas Barrilaco, C.P. 11010
Mexico, D.F., Mexico
Tel: +52 55 5 327 1124
Fax: +52 55 5 327 1123
E-mail: salesusa@psion.com

Psion Teklogix do Brasil, Ltda.
Al. Casa Branca, 851 - conj. 101 e 102
São Paulo - SP - 01408-001
Brasil
Tel: +55 11 3064 0868
Fax: +55 11 3068 8198
WWW: www.teklogixbrasil.com.br
E-mail: tekbr@psion.com

Chile Psion Teklogix International Inc.
Avenida Vitacura 2909, Oficina 703
Las Condes
Santiago, Chile
Tel: +56 2 334 9344
Fax: +56 2 233 3868
E-mail: ventas@psion.com

Psion Teklogix de Argentina, S.A.
Avenida Moreau de Justo 1180
Piso 1, Oficina C-105
Buenos Aires 1107
Argentina
Tel: +54 11 4343 0193
Fax: +54 11 4343 6310
E-mail: tekar@psion.com
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Psion Teklogix España, S.L.
Cityparc Ronda de Dalt
Ctra. Hospitalet 147-149
Edificio Atenas 2° 3ª
08940 Cornellà de Llobregat (Barcelona)
España
Tel: +34 9 3475 0220
Fax: +34 9 3475 0230
E-mail: teklogix@apdo.com

Psion Teklogix Africa
Postnet Suite 39, Private Bag x11
Halfwayhouse, 1685 Ground Floor East
Waterfall Edge Phase 2, Waterfall Park
Bekker Road MIDRAND 1685
South Africa
Tel: +27 11 805 7440/1/2
Fax: +27 11 805 7444

Psion Teklogix Systems India Pvt. Ltd.
M-74, 1st Floor, “M” Block Market
Greater Kailash-Il
New Delhi - 110048
India
Tel: +91 11 621 9257
Fax: +91 11 621 9076
E-mail: tekind@psion.com

Psion Teklogix B.V.
Venrayseweg 57, 
5928 NZ Venlo
Nederlands
Tel: +31 77 32400 44
Fax: +31 77 32400 53

Psion Teklogix Taiwan Co., Ltd.
15FL-5, No. 366 Boai 2nd Road,
Tzuo Ying District, KAOHSIUNG 813
Taiwan, R.O.C.
Tel: +886 7 558 2028
Fax: +886 7 558 3328
E-mail: jerry.chen@teklogix.com

A.4  WORLDWIDE WEB

www.psionteklogix.com
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Boldface indicates a menu or sub-menu name.
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additional programs 8
Afaria 8
AirZip Accelerator 8
alarms

deleting custom sounds 62
recording 62

antenna installation 20
Automatic switch off 58
Axio™ 9

B
backup

restoring files 55
to a PC 55
to multimedia cards 55
using PsiWin 89–90

bar code scanning 26
battery

changing 153
enhanced 1400 mAh 162
fitting 19
monitoring 157
portable charger 162
power 153
prolonging life 156
safety xv, 154
standard 875 mAh 162
4-bay charger 162

Beep on Screen off 59
brightness control 24
Broadbeam Corporation 9
browsing folders 71

C
cables list 163
cancelling a transfer 47
care and safety 7
carrying cases 162
changing

batteries 153
file attributes 73

CIC 9
Citrix ICA 9
city, setting location 53
Click when screen off 59
closing

documents 69
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programs/files 69

command icons 24
communications settings 41
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to PC 54
to serial modem 134

contrast control 24
Control Panel 56
copying

disks 75
files 74, 75
files, using PsiWin 84–88
folders 74, 75
information between programs 34

creating
files 70
folders 69, 71
Outlook profile 192
wallpaper 61
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D
data transfer 45
date 53
DB2 Everyplace 10
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files containing wallpaper 61
files on a multimedia card 77

developers CD 163
device conflicts 177
dialling, setting up 135
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dialogues
buttons 34
using 32

dial-up account 129
disks

backup 55
copying 75
renaming 75
viewing files 68

displaying
amount of memory 75
Control Panel 56
help 5, 67, 128

DNS 131
docking station 37, 39

product packs 161
Universal PSU 161

E
Eliad Technologies, Inc. 9
e-mail 128, 131

account 130
checklist 133
optional information 134
remote account 129
setting up 121, 134, 140
types of accounts 129
web-based account 130

Email program 131
Emissions Information, Canada xv
entering

information 30
owner information 51

Ericom 10
Ethernet configuration 123
exporting/re-importing

a PC PIM with Organizer 190
a PC PIM with Outlook 185
a PC PIM with Schedule+ 7.x 187

exporting a section 191
Extended Systems 10

F
fax/modem 179
FieldWorker 10
files 30, 65, 72

changing attributes 73
copying 74, 75
memory use 76

moving around 67
naming 70
navigating 29
opening 68, 69
rearranging 71
removing 75
renaming 75
selecting 72
viewing on disk 68

folders 65, 72
closing 69
copying 74, 75
creating 71
expand display 71
managing 74
moving around 67
naming 70
navigating 29
opening 68
removing 75
renaming 75

G
glossary of terms 131
GSM/GPRS

antenna 20
SIM installation 20

H
hard reset 170
Help 132

search 5
text scroll 6

hostname 131
HyperTerminal 171

I
IBM 10, 11
icons

command 24
system command 24
troubleshooting 171

IMAP4 131
Impatica 11
Informix Cloudscape 11
Infrared

device safety xv
printing 146
transfer fails 47
using 43
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Index

InkTools™ 9
integrated scanner, safety xv
Intent® 13
Internet 128

account 130
setting up 121, 137

IP address 131
IRDA See Infrared
ISP 131, 134

J
JSmartGrid™ 9

K
keyboard

display 24
entering information 30
Psiboard 24
troubleshooting 171

Ki 12

L
Lotus Organizer See Organizer

M
mailbox

access via a PC 129
accounts 129
connecting through PC 129
connecting to remote by modem 128

memory
card, additional programs 77
displaying 75
file sizes 76
full 76
use, checking 75

menus 24, 32
Microsoft Outlook See Outlook
Microsoft Schedule+ See Schedule+
MMC 37, 39

accessories 163
MobileIntegrator 12
modem

connecting through serial port 134
setting up 136
troubleshooting 179

moving
between files and folders 71
highlight between files/folders 67

to a program 68
MPS 12
MQSeries Everyplace 11
multimedia cards See MMC

N
naming

files 70
folders 70

netpad
care and safety 7
connecting to PC 54
connecting to serial modem 134
overview 4

O
offices list A-3
on-screen keyboard See keyboard
opening

files 68
folders 68

Opera program 131
OPL, interference 169
Oracle Corporation 12
Oracle 8i Lite 12
Organizer

exporting/importing PC PIM 190
synchronizing files 108–117
troubleshooting 195, 196

Organizer 97 GS
synchronizing files 117–120

Outlook
exporting/importing PC PIM 185
failed to open 193
failed to open custom form 195
synchronizing files 91–100
troubleshooting 194

P
page setup 149
Palmware 12
passcode 52
password See also passcode 52, 73
POP3 131
Portable Battery Charger 162
Power 57
Power saving mode 58
PowerTerm WebConnect 10
previewing a document 149
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printing 143
current help card 6
document 150
printer model 148
selecting printer 146
serial printer 147
setting up 145
to a file 147
using Infrared 146
using PsiWin 147

programs 6, 30, 65
additional 77
moving to 68
opening 68, 69
starting 29

programs, additional 8
Psiboard See keyboard
PsiWin

about 81
backing up 89–90
connection problems 174
copying files 84–88
installing 174
opening files 88–89
synchronizing files 90
synchronizing files with Organizer

108–117
synchronizing files with Organizer 97

GS 117–120
synchronizing files with Outlook

91–100
synchronizing files with Schedule+

101–108
troubleshooting 182
using 54
using to print 147

R
rearranging files 71
recording alarms 62
removing

files 75
folders 75

renaming
disks 75
files 75
folders 75

resetting netpad
hard 170
soft 25, 169

restoring files from backup 55

S
safety

battery xv, 154
Infrared xv
instructions xiv
integrated scanner xv
summary ix

scanner use 26
Schedule+

synchronizing files 101–108
7.x, exporting/importing PC PIM 187

screen, overview 24
Screen tap switch on 57
search help 5
securing your information 60
serial printer 147
Series 3/3a/3c/3mx/5/5mx program 77
setting

system passcode 52
time, date, home city 53

setting up
dialling 135
e-mail 121, 134, 140
Internet 121, 137
modem 136
printer 145

SIM, installation 20
SMTP 131
soft reset 25, 169
sorting lists 72
SQL Anywhere Studio 12
stylus

replacement 163
using 23

Subscriber Identity Module See SIM
switching on 18
Switch off after 58, 59
Sybase 12
synchronizing files 90

Organizer 108–117
Organizer 97 GS 117–120
Outlook 91–100
Schedule+ 101–108

system
command icon 24
passcode 52

SystemsGO!™ 9
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TCP/IP 131
temp folder 180
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time 53
toolbar 24
touch screen calibration 28
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Transmit rate 126
troubleshooting 165

alarm 167
command icons 171
docking station 170
fax/modem 179
file vanished 168
general tips 167
keyboard 171
Lotus Organizer 195, 196
netpad basics 175
netpad on/off 168
Outlook 193, 194, 195
passcode (password) 168
PC basics 176
PsiWin 174, 182
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temp folder 180
using HyperTerminal 171
world times 167

turning on/off 23

U
Universal PSU 161

W
wallpaper

creating 61
selecting 61

website address A-4
worldwide offices A-3

X
XcelleNet 8
XML-Run™ 9
XTNDConnect Server 10

Z
zoom control 24

4-Bay Battery Charger 162
802.11

antenna 20
radio configuration 123
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